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Before you start . ..

About This Documentation

This documentation applies to version 2021.10 of the Prinect DFE (Digital Front End).

The Prinect DFE is a digital printing workflow system fully based on the Job Definition Format (JDF). 
Prinect DFE is a component of the Heidelberg Prinect product range.

This documentation provides you with an overview of Prinect DFE. Furthermore, an example is used 
to illustrate how a typical process is set up and run. As an introduction to the offset printing edition, 
the documentation "Quick Start – Prinect Manager 2021.10" (as a PDF document) is available. See 
Prinect Manager Quick Start.

What you should already know

We assume that you are familiar with the Windows® and Mac OS X® operating systems that are sup-
ported by this application. You should also be familiar with the processes and terms used in a digital 
print shop workflow.

Further Documentation

You can find more information in the following documentation:

• in the enclosed "How to get started" leaflet

• in Heidelberg Prinect Licensing - User

• in the Online Help for the Prinect Cockpit

https://onlinehelp.prinect-lounge.com/App/App_pdfs/pdfs/Prinect_Quick_Start_2021_en.pdf
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Symbols and Styles

The following typographical conventions are used in this manual:

• References to other chapters and sections are blue (on the screen) and underlined.

Example: See section "Symbols and Styles", page 6.

• Quotation marks are used to indicate menus, folders, functions, hardware conditions, switch 
settings, system messages, etc.

Example: Set the switch to "off".

• Menus, functions and sub-functions are separated by ">".

Example: Select "File > Open...".

• A plus sign is used to indicate that several keys have to be pressed at the same time.

Example: Press Alt+A.

Important Information

Important information in the text is indicated by symbols at the side which are used as follows:

Warning: Contains information that must be taken into consideration to protect the user 
from injury.

Caution: Contains information that must be taken into consideration to prevent damage to 
hardware or software.

Note: Contains important general or supplementary information about a specific topic.

Prerequisite: Lists requirements which must be fulfilled before the steps which follow can 
be performed.

�

�
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Basic Concept of Prinect DFE

Prinect DFE provides functionalities for an automated Prinect workflow for output on HEIDELBERG or 
Gallus digital presses. This workflow spans steps ranging from preparation of the digital job data to 
output of the production run at the digital press and finishing of the printed products.

What are the Components of a Prinect DFE?

Prinect DFE is built up on the model of a server-client architecture. The core of the system consists 
of a central database and components that control all the processes in the system and that regulate 
communication flow between the single components. Important basic data like for example, printing 
materials, user or customer data, color profiles, are stored in the MDS (Master Data Store). Job pro-
cessing is done by "engines".

The user interface of the Prinect DFE is the "Cockpit" that can be installed as a client application on 
several computers in the network environment.
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How Do I Use Prinect DFE?

The "Cockpit" is the central user interface for all work that a user does on Prinect DFE. The Cockpit 
is installed together with the DFE software on the DFE server computer. Additional Cockpit clients 
can be installed via the Prinect Maintenance Center (PMC) as well in a Windows as in a Mac OS oper-
ating system environment. You can perform the following tasks in the Cockpit:

• Edit basic system settings (create users and customers, enter spot colors, etc.),

• configure processing steps ("Sequences") for automated job processing and

• create jobs, compile job components (input files, sheet layouts), view and monitor jobs, submit 
jobs or job data for processing or for approval, check the job status.

Prerequisite: A licensed, if possible latest, version of the Adobe Acrobat Professional soft-
ware should be installed on each workstation using the Prinect Cockpit. Acrobat Professio-
nal is used for various purposes during the processing of print jobs in the Prinect DFE work-
flow, e.g. for the visual inspection of PDF documents or for using the Acrobat plug-ins 
"Prinect PDF Toolbox" or "Prinect Imposition Editor". This software is not included in the 

Additional Cockpit work-
station

Communication services, Mas-
ter Data Store

Prinect Cockpit Prinect Cockpit

Prinect Color Toolbox

DFE server PC

Prinect engines,
renderer

High Performance
Renderer (only for Labelfire)

Prinect Color Toolbox
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shipment of the HEIDELBERG Prinect software. The operator of the Prinect software is 
responsible for seeing to it that Acrobat Professional is installed on each Prinect computer 
before installing the Prinect DFE software.

How Does Licensing Work?

Prerequisite: HEIDELBERG offers two solutions for operating digital printing presses with 
the Prinect workflow: the Prinect Production Manager or the "Prinect DFE Versafire Stand-
alone" variant. In addition to the offset workflow, the Prinect Production Manager supports 
all digital printing presses that are generally supported by the Prinect workflow. The "Prinect 
DFE Versafire Standalone" variant is intended exclusively for operating digital printing 
presses. To install this variant, you need the "Prinect DFE Versafire Standalone" installation 
package, which contains all the software components required for this variant. The "Prinect 
DFE Versafire Standalone" installation package can be downloaded from the Prinect Main-
tenance Center in the "Product installations" view. This variant is described below.

If the Prinect DFE software is to be initially installed in a system environment in which no other Pri-
nect product is already installed, there is usually no Prinect Maintenance Center installation available 
in the system environment. In this case, you can download the Prinect Maintenance Center installa-
tion package from the HEIDELBERG homepage in the "Software" menu under "Prinect Software 
Downloads" and install it in your system environment.

See Prinect Software Downloads.

After installing the Prinect Maintenance Center (PMC), you must register your company and at least 
one user in the HEIDELBERG customer portal in the PMC user interface and log in to the customer 
portal. Information on this can be found in the online help for the Prinect Maintenance Center.

How does licensing work?

With each installation of the Prinect DFE software, all software components of the "Prinect DFE Ver-
safire Standalone" installation package are installed – regardless of the licenses purchased. The num-
ber of permanently usable options that you can use is controlled by a license key. The activation of 
the options and the management of the licenses is controlled by the "Prinect Licensing" module. Pri-
nect Licensing consists of two software components, the License Server and the License Manager. 
The licenses are activated online via the HEIDELBERG Trust Service. As of version 2019, dongle-based 
licensing is no longer supported - with a few exceptions. For version upgrades, online licensing may 
be used.

Online licensing is based on an online protection certificate that is activated during software installa-
tion. Therefore, before installing the Prinect DFE software, you must request an installation code from 
the HEIDELBERG licensing department, which you enter at the appropriate point during the installa-
tion of the License Manager software to enable activation. The certificate is tied to real or virtual 
hardware and is automatically renewed daily. If the Internet connection to the HEIDELBERG Trust 

https://www.heidelberg.com/global/en/software/workflow/prinect_updates/prinect_downloads.jsp
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Service is temporarily lost, the existing certificate remains valid for 30 days. Online licensing is man-
aged with the "Prinect Licensing" module, while the connection to the HEIDELBERG Trust Center is 
established via the Prinect Maintenance Center.

The License Server and the License Manager interact in a "client-server architecture". Administration 
of the licenses is done in the License Server whereas the License Manager depicts the user interface. 
The License Server is usually installed on the Prinect DFE server. In bigger system environments with 
a number of DFE servers, it may be advisable to set up a dedicated License Server PC. The License 
Manager user interface can be installed and used on multiple client computers simultaneously.

Note: You can find details about licensing in the "HEIDELBERG Prinect Licensing – User 
Manual" or in the License Manager Online Help.

Prinect Maintenance Center

The Prinect Maintenance Center establishes the connection in the print shop to the HEIDELBERG Pri-
nect Software Center (for software downloads), the HEIDELBERG Trust Service (for licensing) and the 
HEIDELBERG customer portal Control Center.

Within the Prinect system environment, the Prinect Maintenance Center is responsible for various 
tasks:

• For the provision of installation files for the installation of the Prinect software in the print shop,

• for regular checking for available software updates and their provision,

• for controlling update installations, taking into account the dependencies that exist internally 
between the Prinect components, and

• for performing background installations that occur without user interaction.

The prerequisite for providing Prinect software components is that the printing company is registered 
and logged in as an organization and with a user account on the HEIDELBERG customer portal. The 
HEIDELBERG customer portal gives you access to the digital services of Heidelberger Druckmaschi-
nen AG.

Sequence Templates

In the Cockpit, the processing operations are configured as "sequence templates". These templates 
contain all process steps that are to be carried out with the content data of the print jobs up to the 
actual printing process. Sequence templates contain – divided into different options – all the import-
ant settings that are required for correct print output. These templates only need to be configured 
once and can then be used for any number of print jobs that require the same parameterization. 
Sequence templates of different types can be combined to form group templates. When creating a 
new print job, it is usually sufficient to enter a few basic data and select the appropriate sequence 
templates or a group template. See "Group Templates", page 11. All output parameters are predefined 
in the sequence templates and do not need to be configured again.

�

�
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Basic sequence templates

The most important sequence types for digital print output are "Qualify" and "PagePrint". Other types 
of sequences are available for advanced workflow options, depending on the licensing options you 
have.

• The Qualify sequence uses a "normalization" option to prepare documents in PDF format for 
processing with the Prinect DFE workflow. If the PDF format is not suitable for processing with 
the Prinect DFE workflow, these PDF documents can be prepared with the "normalization 
engine" so that further processing can take place in the Prinect DFE workflow ("refrying" pro-
cess). In principle, the input documents must be in a cleaned PDF format that is suitable for the 
subsequent process stages. In a "preflight" option, the input documents can be checked for the 
presence of all required fonts, the correct image resolution, the use of transparencies, etc. The 
preflight settings can be adapted to the respective requirements.

• After completing the Qualify sequence, the pages can be processed using a "Prepare" sequence. 
This is necessary, for example, if transparencies contained in multiple layers of a PDF document 
are to be reduced to one layer. The Prepare sequence also offers advanced color management 
options.

• In a PagePrint sequence, output to a digital press is configured. In this case, the majority of the 
print parameters are defined interactively during job processing.

• An ImposedPrint sequence is used to configure the sheet output for digital printing. This 
sequence type enables the output of fully imposed sheet layouts on digital printing presses.

Group Templates

To configure a standardized processing, you can group several sequence templates into "group tem-
plates". In a group template, individual sequences can be connected to one another by graphically 
drawing connecting lines. Sequence templates connected in this way are automatically executed one 
after the other without the need for user intervention. Connecting sequence templates is optional and 
in the examples shown below the sequence templates are not connected. You can save separate 
group templates for different sequence configurations.
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Job Processing Workflow

The graphic below shows you a diagram of the basic workflow in processing job files in the Prinect 
DFE workflow:

Files from a customer or from 
an editorial department

are generated as PDF or PDF/VT files.

Digital Press

Preparation (Qualify) PagePrint Digital Printing Terminal
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1. The printing company's customer delivers the documents and/or images required for the print 
job to the printing company in the form of PDF files or image files (e.g. in JPEG format). The 
complete definition of the print job can be done in a web shop, for example, and also the PDF 
and image files can be transferred to the printing company this way.

2. When the input files are available at the print shop, a new job is created in the Prinect Cockpit. 
If several print jobs are expected for a specific customer, a job group can be created in which the 
print jobs of a customer are grouped together. It is also a good idea to enter the customer's data 
(name, contact person, etc.) in the Prinect customer management and assign the new job to the 
customer.

3. When creating a new print job, you can assign several sequence templates or a group template 
to the job.

4. After a print job has been created in the Prinect DFE workflow, it is opened in the cockpit. Exis-
ting settings can now be checked and adjusted if necessary. For example, individual sequence 
templates can be modified.

5. After the job has been created, the files to be printed are added to the job. The job can be 
defined as "started" when it is created. The added files are then processed immediately – usually 
with a "qualify" sequence, which contains a preflight step that checks the files for possible errors 
(missing fonts, image resolutions that are too low, etc.). Job parameters such as color settings 
(color sequence, handling of special colors, etc.) can then be configured.

6. You can also optionally define job templates for automatically creating new print jobs. Then you 
just need to transfer the files to be output into a hot folder using "drag & drop" and a new job 
will be automatically created with the default settings of the job template (see section 
"Automatic Creation of New Jobs using Drag-and-Drop", page 67).

7. For output to a digital printing press, the individual pages must be imposed. This is done either 
interactively in the "Digital Printing" step, or in a preceding step in which the sheet layouts are 
imposed separately (e.g. with the Prinect Signa Station or with the Prinect Imposition Editor). In 
this case, an ImposedPrint sequence is used for the digital printing output, rather than a Page-
Print sequence. All settings for the print output – including the finishing – are made in the "Dig-
ital Printing" step.

8. After the configuration of the "Digital printing" work step is completed, the print jobs are for-
warded to the digital printing terminal (part of the Prinect Cockpit). The digital printing terminal 
can be used in two operating modes:

· In automatic mode, incoming print jobs are automatically forwarded to the digital prin-
ting press, i.e. without the need for operator intervention. If there are several "similar" 
digital printing presses in the system environment, these printing presses can be combi-
ned to form a "cluster". These machines can then be operated in "load balancing" mode, 
i.e. the digital printing press that is currently available or is least busy is automatically 
controlled. See "Set up the cluster configuration", page 40.

· In manual mode, the operator controls the order in which the print output occurs and – 
if several digital printing presses are available – which printing press is addressed.

9. The print jobs arrive at the digital press from the Digital Printing Terminal and are output on the 
press.
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Set up Users

Prerequisite: Before you set up new users in the Prinect Cockpit, the corresponding user 
accounts must be set up in the Windows system administration of the Prinect DFE Server 
computer. The future Cockpit users must first be defined with a Windows user account on 
the Prinect DFE Server and be a member of the Windows user group "Prinect Operators". 
Without this setup and configuration as a Windows user, the Prinect users cannot make any 
changes to the settings or to the job data in the Prinect Cockpit. You can find more informa-
tion in the Cockpit Help under "Setting up a new Prinect user".

After installing the Prinect DFE software for the first time, you must set up the print shop employees 
who are to operate the Prinect DFE workflow as "Prinect users". During setup, you assign the 
intended roles to the individual users by assigning them to a specific user group and assigning the 
corresponding access rights. You can access user management in the "Administration" view of the 
Prinect Cockpit under "Users".

Note: If the Prinect DFE software has been newly installed, you can log in to the Prinect 
Cockpit with the user name "Administrator" without a password to set up the users. For 
security reasons, we recommend that you then delete the user "Administrator" from the 
user management.

1. Go to "Administration" and click "Users" (1).

2. User administration opens. Click the "New" button. The "Create User" dialog opens:

�

�
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Enter the following user data:

· The user name: Enter the user name (in the example "PeterP"). This user name is used 
as a user account within the Prinect environment – especially in the Cockpit. At the same 
time, this user account must be defined as a Windows user on the operating system of 
the DFE server computer (see "Requirements" above). In order to use the corresponding 
Windows user account as a Prinect user account, the "Password for OS login" option 
must be activated. Only if an appropriately configured Windows user account is used for 
the Prinect user at the same time can the Prinect user access the "PTConfig", "PTJobs" 
and "PTDocs" folders with write permissions when the protection function is activated. 
Without these permissions, no changes to the settings or job data can be made or saved 
in the Cockpit. Enter a user name here that is defined as an appropriately configured 
Windows user on the Prinect DFE server computer. This (or another appropriately con-
figured) user account will be used to log in to the Cockpit in the future.

Note: If you operate the Cockpit on a computer other than the Prinect DFE server, i.e. on a 
Windows or Mac client, the Prinect user does not have to be a system user on the client 
computer at the same time, but only on the Prinect DFE server.

· Optionally, you can specify the name of a Windows domain if the Prinect DFE server and 
– if present – ​​the client computers and the corresponding users are organized in a 
domain.

For further information on the protection function, please refer to the Cockpit Help under 
"Administration > Security".

�

�



Introduction

16 Version 2021.10

3. In the "Person" area, you can enter additional, personal data about the user (email, employee 
number, first name, last name). Optionally, you can select a profile picture of the user in the file 
system and assign it to the user.

4. Confirm the dialog with "OK". The new user is now displayed in the "Name" column. Mark this 
table entry and assign the user the user groups of which he should be a member by marking the 
desired groups in the "Available groups" list and adding them to the "Member of" list by double-
clicking them or by clicking "Add".

Note: In the vertical tabs "Groups" and "Access Rights" (top left of the window) you can edit 
or redefine user groups and configure the corresponding access rights. You can find more 
information about this in the Cockpit Help under "Administration – Users".

5. Finish the user configuration by clicking "Save". Click on "Overview" to leave the "Users" admin-
istration area.

Set up Customers

In everyday use of the Prinect DFE workflow, the processed jobs are normally assigned to the relevant 
customers. For this purpose, Prinect DFE contains its own customer management. The customer 
information is stored in the master data store and is available at various locations in the Prinect envi-
ronment.

Note: Detailed information on customer management can be found in the Prinect Cockpit 
online help.

In order to be able to assign a customer to the demo jobs, a "virtual customer" is set up here as an 
example:

1. Go to the "Administration" area and click on the "Customers" icon (1).

2. The customer management opens. Click on the "New" button. The "Create customer" dialog 
opens.

�

�

�

�
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Enter the following customer data:

· Sector: Business

· Name: HD Printshop

· Customer ID: 0001

· Nickname: HDP

3. Click "Open" beside "Person". The "Create Person" dialog opens:
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Enter the following personal details:

· Title: Mr.

· First Name: William

· Family Name: Bauer

· Nickname WillB

· Language: English

These details about the contact are enough for our purposes. In "Communication Channels", 
you can enter data such as phone number, mobile number, e-mail address, fax number or Web 
address.

Confirm the "Create Person" dialog with "OK".

Then confirm the "Create Customer" dialog also with "OK".

4. The "Customers" window now displays your new customer at the top left of the customer list.



Introduction

Prinect Digital Front End – Quick Start Guide 19

Mark your customer and fill out the "Address" section.

· Street: Hauptstraße 1

· Postal Code: 10111

· City: Berlin

· Region: Berlin

· Country Code: DE

· Country: Deutschland

5. Confirm your inputs with "Save". Close the "Customers" window by clicking "Overview".

Create a Job

In the Prinect DFE workflow, a job contains all the information and files required for processing. New 
jobs are created in the "Jobs" view using the "New job" button. When defining a new job, the follo-
wing information is requested:

• Basic job data

· Job Number

You must assign a job number to each job. A job number generally consists of a number 
of letters and/or digits. The job number identifies each job in the DFE system. For that 
reason, each job must have a unique job number. This is checked when you enter a new 
job number. If the job number you entered already exists, the number displayed is red 
and you cannot enter any more data until you enter a job number that is not yet used.
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· Job Name

The job name is the identifier that is used to display a job in the Cockpit user interface. 
The job name, too, must also be unique in the system. This means that you must give 
each job a job name that is not yet used as a job name in the system. If you hit the Tab 
key after entering the job number, the job number is copied automatically to the "Job 
Name" box. You can use the job number also as the job name or you can edit this entry.

· Documents

Here you can assign PDF or image files to the job when you create it. To do this, click on 
the "Browse" button and select the relevant files in the file system. You can also skip this 
step and add the document files later, after the job has already been created and 
opened.

· Job Group

Generally, it is advisable to create each job in a job group. This lets you use a separate 
group, for example, for each customer you have or you create a "pool group" for single 
jobs of various customers. If an job-related group structure already exists in the system, 
the group that was selected before clicking the "New Job" button is entered in this field. 
By clicking on "Change" you can select another existing group or create and select a new 
group.

· Job Home

This field defines the folder in which all job-related files are stored in the file system. The 
job files are normally stored in the "PTJobs" system folder (e.g. E:\PTJobs) of the DFE 
server and here in the "Jobs" subfolder. A subfolder with the name of the job group is 
created within the "PTJobs" folder and within this a folder with the job name. All job-
related files are stored in this folder. If you want to deviate from this specification, you 
must click on the "padlock" symbol. This removes the link between the job group and the 
job folder and you can select a different folder for the job files by clicking "Change". We 
recommend that you only do this in exceptional cases, as the default settings ensure that 
the job files can be found quickly in the system. Since the "PTJobs" folder is shared on 
the network, the job files can also be accessed from other computers in the system envi-
ronment – e.g. from other cockpit computers. In addition, the central storage of all order 
files makes data backup easier.

• Customer Data

The assignment of customer data to a job is optional, but it is strongly recommended that you 
use the Prinect customer management (see section "Set up Customers", page 16) and assign a 
corresponding customer account to each job. The customer names registered in the customer 
management are offered for selection in the "Customer name" selection list. The "Customer ID" 
and "Nickname" fields are then filled in automatically.

· Customer Job ID
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The assigned Prinect job ID is entered by default in this box. You can enter a "customer 
job ID" in the case that your customers use their own job IDs that are different to the Pri-
nect job IDs.

· Customer Job Name

Similar to a customer job ID, you can enter a different customer job name in the case 
that your customers use their own job names that are different to the Prinect job name.

• Processing

In this view, you can assign one (or more) sequence templates or one (or more) group sequence 
templates to the job using "Add". This assignment determines how the job is processed using the 
Prinect DFE workflow. The work steps defined in the sequence templates can still be edited indi-
vidually after the job has been created. You can also save the selected sequences as a template 
for automatically generated jobs (see also chapter "Automatic Creation and Output of New Jobs 
using Drag-and-Drop", page 67). You can also skip this step for now and assign the required 
sequence templates later in the open job.

• Scheduling

In this step, you can enter details about the following scheduling data:

· Set Due Date

You can select a date for the scheduled due date by clicking the calendar icon. This date 
is for logging only and does not control the time printing will run.

· Responsible

Enter the name of the Prinect user who is responsible for processing the job. By default, 
this is the name of the user logged in to the Cockpit. Using "Select", you can select a dif-
ferent name from the Prinect user administration. The user must have the required per-
missions in the Prinect system.

· Job type

You can select one of the following job types in the list box: Production, Product, Prelim-
inary job, CAD (for packaging printing), Reuse, Job Template, Cloud.

· Job Priority

You can assign a priority to each job. For example, this lets you set that very urgent jobs 
are given a higher priority and are processed before other jobs.

· Pages

Generally, the job data or information from the customer tells you how many pages the 
job has. Together with the planned delivery quantity, you can estimate how big a job will 
be.
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· Delivery quantity

The delivery quantity indicates how many copies of each printed product are to be 
printed.

The new job is created after you click "Finish" and opens immediately if the "Start Job" option is 
enabled.

Processing Steps and Parameters of a Prinect Job

In the Prinect workflow, each print job goes through several processing steps before being printed. 
The properties of a Prinect job can be viewed and configured in different parameter areas in the 
"Jobs" view of the Cockpit. After the job has been set up, it is started and the processing steps are 
carried out one after the other.

A job contains the following parameter sections and/or processing steps:

• "Product Description" section

This is where data like delivery quantity and details about the customer for whom the job was 
created are entered.

• "Processing" Section

This is where the processing sequences or group sequences are added to the job and displayed 
in a graphic overview. Sequence settings can be edited individually here (by double-clicking on 
the respective sequence symbol).

• "Properties" Section

This is where other properties like delivery quantity, pages planned in a job, predecessor job 
details or gang job details are recorded.

• "Colors" Section

Here, the type of output of the printing colors defined in the job (color definitions, color 
sequence, usage, etc.) is configured.

• "Printing Process" Section

Parameters relevant to the printing process (e.g. the printing order of the pages or the output 
color profile) are displayed or configured here.

• "Documents" Step

Document (PDF files or image files) are added to the job in this step.

• "Pages" Step

In this step, page lists are defined and the document pages are assigned to the page list place-
holders. In the examples described below, this happens automatically, so this step does not 
have to be processed manually.
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• "Digital Printing" Step

In the "Digital Printing" step, pages are imposed interactively and you set output and finishing 
options. Furthermore, this step has options for examining the imposed sheets in detail (magni-
fier function, etc.) and you can, for example, view a preview of a finished booklet in which you 
can also scroll through.

• "History" Section

List of the actions performed throughout the job.

Set up a Cluster of Digital Presses

You can combine several Versafire digital printing presses (Versafire EV/EP or newer) into a cluster. 
You can then forward print jobs to the cluster. This means that it is only decided at the moment of 
printing which of the printing presses belonging to the cluster will be used for printing. If the digital 
printing terminal of the Prinect Cockpit is operated in automatic mode and a cluster of digital printing 
presses is selected as the output destination, these digital printing presses are automatically used to 
their full capacity, as the machine with the highest availability is always used. In manual mode, you 
can select either one of the individual machines or the cluster and submit the print jobs accordingly.

Note: When setting up a cluster, you should note that the presses involved have properties 
of the same value, e.g. that they have the same paper size, the same printing materials and 
the same colors as well as the same finishing options, if required, because presses config-
ured in the cluster are operated in "Load Balancing". In other words, it is automatically 
decided during operation which machine is to be driven. However, some properties of the 
printing machines can be configured as selection criteria for the automatically controlled 
printing presses. See also "Set up the cluster configuration", page 40.

Prerequisite: At least two suitable digital presses are available and set up in the Prinect 
DFE system environment. In the following example, two Versafire EM digital presses are to 
be combined to one cluster.

Proceed as follows to set up a cluster made up of digital presses:

1. In the Cockpit, open the "Administration > System" view, select the DFE server entry in the struc-
ture view on the left and click on the "Show Clusters" button.

2. Mark "DigitalPagePrinter" in the right pane and select "Create Cluster" in the context menu.

�

�
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3. Enter a name for the cluster and confirm with "OK".

The cluster is created. The presses must now be assigned to the cluster.

4. In the left pane, below "Digital Serices" (1) select the first Versafire machine and select "Add to 
Cluster" in the context menu.
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The "Add Device to Cluster" dialog opens:
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5. Select the cluster created beforehand, in the example "Versafire_EM_Cluster", and confirm with 
"OK".

6. Repeat steps 4 and 5 for the second Versafire machine. Now both Versafire machines are 
included in the cluster.

7. Check the setup by clicking the triangle in front of "DigitalPagePrinter" in the right pane. The 
content of this item displays. If you click the triangle in front of "Versafire_EM_Cluster", the two 
digital presses in the cluster display:
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8. Now you can switch back to the "normal" view by clicking "Hide Clusters".

Configure Sequence Templates

Prerequisite: In order for the "PagePrint" sequence needed for digital printing to be avail-
able, a suitable digital press must be set up on the Prinect DFE. In addition to installation 
of the press, the machine must be set up in the Prinect Cockpit in "Administration > System 
> Digital Presses". You will find details about the connection of digital presses in the Online 



Introduction

28 Version 2021.10

Help of the Prinect Cockpit in "Connecting Machines > Connecting Digital Presses". You can 
also set up clusters for Versafire presses (EV and EP or later). See "Set up a Cluster of Digital 
Presses", page 23.

To configure the sequence templates needed for the examples below, proceed as follows:

1. Go to "Administration" and click "Templates".

2. The "Templates" window opens. Click the folder icon beside "Sequence Templates" to display 
the single sequence items.

Configure a Qualify Sequence

1. Highlight the "Qualify" sequence type (1) and click "New" (2).

The setup section for a new Qualify sequence opens:
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Set this sequence as follows:

2. Leave "Normalizing", "Split Document" and "Destination" disabled or as they are.

3. Enable "Hotfolder" and leave the defaults as they are.

4. Enable the "Preflight" option and display the parameters by clicking the small triangle before the 
checkbox.

5. Click "Browse" in the "Heidelberg Preflight Profile" section of the "Actions" tab. Select the 
"CMYKDefault.hpp" profile.

6. Click "Save as". The "Save Template" dialog opens:
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7. Type the name "Qualify_HDCity" and select the customer "HD Printshop" under "Customer ID" 
using "Edit". All customers registered in the Prinect customer management are offered for selec-
tion. The customer ID (in the example 0001) is then inserted in the corresponding field. Confirm 
the "Save template" dialog with "OK".

8. Click "Close". The sequence overview displays.

Configure a PagePrint Sequence

Prerequisite: The "PagePrint" sequence type is available only if at least one digital press is 
connected to and set up on Prinect DFE.

In the "Templates" view, highlight "PagePrint" in "Sequence Templates" and click "New".
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"Accept approved pages only" Option

This option is intended for an approval workflow in which the prepared documents must be approved 
by the customer or a print shop employee before the actual printing process. If this option is acti-
vated, only PDF pages that have been given the status "approved" will be processed in the further 
course of the workflow. You can find more information about the approval workflow in the Cockpit 
online help. We leave this option deactivated.

"AutoImposePDF" Option

This option is always activated and cannot be edited. It means that in digital printing, all document 
pages are always assigned to the corresponding page list placeholders. The page lists are automati-
cally generated according to the number of pages and the page format defined in the job settings. In 
the Prinect offset printing workflow, the content pages of the supplied document files must normally 
be assigned to the page placeholders of a page list in a special imposition step. To do this, the 
required page lists are generated manually or taken from an imported sheet layout. In digital printing, 
this imposition process takes place automatically with the "AutoImposePDF" option.

"Digital Printing" Step

In this step, you can set up parameters for paper, pages, layout, print marks, color as well as print 
and finishing settings of the press and save them as a template. These presets will be adopted later 
when configuring the "Digital printing" work step in the opened job and can be individually adjusted 
there.

Selection of the digital press

In the "on" list box select the digital press for which you will set up this PagePrint sequence template. 
If there is only one digital press in the system, this press is automatically selected.

Note: You can combine several Versafire digital presses (Versafire EV/EP or later) to a clus-
ter. In this case, you can select a cluster of digital presses in the "on" list box instead of a 
single digital press. See also "Set up a Cluster of Digital Presses", page 23. The digital prin-
ting presses included in the cluster are then controlled with the parameters of this PagePrint 
sequence and operated in "load balancing".

Configuration of paper and page settings

1. Open the "Digital Printing" step and in the "Paper and page settings" tab set, for example, an A3 
paper type as the paper:

�

�
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The paper types are set up at the press and these data are sent to the Prinect Cockpit. If 
required, you can select a different paper type from the "Paper" list box. If you change the paper 
size, the new size displays at once in the preview pane.

(2). On some digital presses it is possible to print the cover pages (the first two and last two pages 
of the PDF document) on different paper. In the example, the cover pages are to be printed on 
the same paper as the content pages.

Note: In the page preview, the cover pages are highlighted by a dark yellow label.

3. Leave "Non-printing Margin" as it is (0,0). This can be a good idea for some jobs, for example, 
where logos or business cards are not to be printed right up to the edge of the paper.

4. Leave the "Subject Offset (manual)" option disabled.

Note: This option lets you manually set the horizontal and vertical spacing between the sin-
gle subjects on the printing material. You can use this, for example, for printing labels or 
business cards.

5. In "Imposition Trimmed Size" leave "From PDF" as it is. Likewise, leave "Scale" as "100%" and 
"Page Policies" as "Fit to Size". "Expected Orientation" is set to "Portrait" and cannot be changed 
if "From PDF" is set.

6. In the "Bleed and Trim Allowance" section enter 3.0 mm in the "Bleed" box. Then hit the Tab key. 
The new value is applied to the preview. Set "Trim Allowance" to "Automatic".

�

�

�

�
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Configuration of the layout settings

1. Go to the "Layout settings" tab and select the "booklet layout" (1).

2. Select "Saddlestitch" in the "Binding" list box (2).

3. Enable "AutoArrange Folding Sheets" (3).

4. Enter a value of 0.1 mm in "Creeping" (4).

5. Enter a value of 1.0 mm in "Back Margin" (5).

Leave all other settings as they are. Detailed information on the individual options can be found in 
the Cockpit online help.

Note: Use the "custom layout scheme" button (6) to open a Layout Scheme Editor where 
you can create a custom layout scheme. You can find details about this in the Online Help 
of the Cockpit (F1 key).

�

�
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Configuration of the print mark settings

1. Go to the "Print mark settings" tab. Because no print marks will be used in this example, leave 
all the options disabled or disable any checked options.
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Configuration of the color settings

1. Go to the "Color settings" tab and activate the "Enable Color Management" option.

2. Open the "Source Profiles" area.

3. Leave "Enable CMYK Color Management" and "Use Embedded Profiles" enabled.

4. If needed, you can customize the "Keep Black", "Spot Colors" and "Output Profile" sections by 
clicking the respective triangles. These settings are not changed in our example. Details about 
these parameters can be found in the Online Help of the Prinect Cockpit.
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Configuration of print and finishing settings

1. Go to the "Print and finishing settings" tab.

2. Depending on the equipment of the printing machine, different printing and post-processing set-
tings are available. Parameterize the settings according to the requirements of the print jobs that 
are to be processed with this sequence. Information on the printing and post-processing settings 
can be found in the documentation for your printing machine. Some configuration settings are 
described as examples in the Cockpit Help.

Save sequence template

1. Click "Save As". The "Save Template" dialog opens.

2. In the "Template name:" field, enter the name "PagePrint_HDCity".

3. Assign the customer "HD Printshop" to the sequence template by clicking "Edit" next to the 
"Customer ID" field and confirm the dialog with "OK". The dialog closes.

4. Close the PagePrint sequence template by clicking "Close". The template overview is displayed.

Create a Group Template

For the processing of a job it is not absolutely necessary to create a group template but the use of 
group templates facilitates the processing of further print jobs that need similar processing steps. A 
group template will be created to illustrate how you define and use a group template.
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1. In "Administration > Templates", mark "Group Templates" in the sequence overview and click 
"New".

The empty setup window of a group template opens.

2. Open the "Qualify" folder and select "Qualify_HDCity" (1).

3. Then click "Add Template" (2).

An icon for the Qualify sequence is created in the workspace.

4. Repeat steps 2 and 3 also for the "PagePrint_HDCity" sequence. The workspace now displays as 
follows:

5. In the workspace, select "AutoArrange" in the context-sensitive menu. The icons are placed side 
by side and aligned.

6. Click "Save As". The "Save Template" dialog opens.
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7. Enter the name "HDCity_Group_Template" and assign the customer "HD Printshop" to the group 
template. Confirm and close the dialog with "OK".

8. Close the group template by clicking "Close".

9. Exit the "Templates" view by clicking "Overview".

All the sequence templates needed for a basic workflow are now configured.
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Configure the Digital Printing Terminal

The Digital Printing Terminal is the link between the submitted Prinect print job and the digital press. 
You will find details about the prerequisites and operation of the Digital Printing Terminal in the 
Online Help of the Prinect Cockpit (F1).

You can configure the Digital Printing Terminal for two modes:

• for the manual output mode or

• for the automatic output mode.

In the manual output mode, you can customize which print jobs will be sent in which order to the 
press.

In the automatic output mode, the print jobs are submitted automatically to the press in the order in 
which they arrive at the Digital Printing Terminal.

You open the Digital Printing Terminal by clicking its button (1) in the section toggle.

If more than one digital press, an additional CTP device or a cluster of digital presses is set up on the 
Prinect DFE, you can select the output device or cluster you wish to control in the Digital Printing Ter-
minal in the device list box (3).

The layout and the contents of the windows of the Digital Printing Terminal are refreshed if you 
change the output device. This means that the jobs and details of the new output device you set dis-
play in them.

Note: The "Jobs" view also has a "Digital Printing Terminal" section. This view is designed 
to give you a fast overview of the progress of digital printing. However, you cannot control 
printing from this view.

�

�
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Configure the automatic output mode

The automatic output mode is set by default after installation. You can switch to the manual output 
mode by disabling the "Automatic Output Mode" option. To do this, click the "Device configuration" 
button (2). The "Device configuration" dialog opens:

In this dialog, you can disable the "Automatic Output Mode" option.

The automatic output mode will stay enabled for the workflow described in this documentation.

Set up the cluster configuration

Prerequisite: In order to configure and use clusters of digital presses, you must have set 
up at least one cluster. See "Set up a Cluster of Digital Presses", page 23. In this case, the 
job must be submitted to a cluster of digital presses.

If you want to use several digital presses in a cluster, you can set up the way the print jobs will be 
distributed in the Digital Printing Terminal. Then the cluster of these digital presses is offered in the 
device list box (3). Click on the cluster in the list without selecting one of the machines in the sub-
menu. You can now configure the entire cluster. In a cluster, the print jobs can be distributed to the 
individual machines in the cluster according to various criteria. In this way, the machines in a cluster 
can be better utilized than individual machines. You configure the distribution details in the "Cluster 
setup" dialog.

When you select a cluster, the Digital Printing Terminal view changes to the effect that only the "Print 
History" and "Cluster Setup" buttons display in the global status panel. In the cluster view, you can 
use the "Machine" column in each table for sorting or grouping.

When you click one of the machine icons of the cluster, the cluster view changes to the view of that 
machine.



Introduction

Prinect Digital Front End – Quick Start Guide 41

Accept automatically distributed print jobs

When you select this option, the digital press concerned is made available for automatic distribution 
of print jobs in a cluster if "Machine-specific" is selected in the "Automatic Output Mode" option in 
the "Cluster Setup" dialog.

Cluster setup

"Automatic Output Mode" option

If you activate this option, the automatic output mode is enabled, i.e. incoming digital print jobs are 
immediately submitted to that printing press which corresponds to the activated criteria under "Allow 
Automatic Match for" and which is available next.

If you deactivate this option, the print jobs which are submitted to the cluster, are collected in the 
"Waiting Print Jobs" area. Here you can open the "Start with Settings" window with the respective 
context menu item, and select the machine of the cluster to output the job:
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Prerequisite: This list box is only available if a cluster is selected in the device list box.
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"Allow Automatic Match for" options

You can use these options to confine automatic distribution of print jobs. If you activate one ore more 
of these options, the print jobs are distributed automatically, corresponding to the activated criteria.

• Printing material

The printing material parameters like size, grammage, paper grade, grain direction etc. are taken 
into account when selecting a press, i.e. the press whose printing material settings best match 
the respective job will be driven.

• Output Profile

When this option is enabled, output is matched to the default ICC profile of the selected paper 
on the press. However, this matching is done only if the machine type automatically assigned 
differs from the machine type originally assigned or if there was a change in paper.

• Quality Options

When you enable this option, print jobs are also submitted to machines in a cluster that do not 
have quality options like "Edge Enhancement" or "Maximum Inking", even if these parameters 
were enabled for the submit process. In this case, these quality options are ignored.

• Output Tray

When you enable this option, printing is automatically matched to the existing output tray 
parameters of the press in the cluster. Finishing options like stitching, punching or folding are 
always taken into account. This means that if a machine in the cluster does not have the finish-
ing options configured in the job, it is not automatically selected.

Automatic Workflow by Dragging-and-Dropping 
Document Files

You can use the DFE for automated job processing where new print jobs are created automatically 
when you drag-and-drop document PDFs in the job list of the Cockpit. In this process, it is enough to 
save the required sequences as a template in a new print job. You can find details about this workflow 
in the chapter "Automatic Creation and Output of New Jobs using Drag-and-Drop", page 67.

Automatic Workflow in the Hotfolder Mode

Another variant of automated job processing works using special folders called "hotfolders". A new 
print job is created automatically whenever document files enter such a hotfolder. You can find 
details about this workflow in the chapter "Automatic Creation and Output of Print Jobs in the 
Hotfolder Mode", page 75.
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Manual Creation of a Print Job

This chapter shows you how to create a print job (example: "HDCity" booklet) manually and edit it up 
to printing.

Note: The examples shown in this documentation solely demonstrate operation and must 
not be understood as imperative instructions.

Create and Edit a Job

After you prepared the sequences that are needed (see the section "Configure Sequence Templates", 
page 27), all the prerequisites required for creating a new job are met.

Prerequisite: All the prerequisites required for creating a print job in the Prinect DFE are 
now listed once again below:

· The document file(s) to be printed: HD_City.pdf in the example

· Customer: HD Printshop

· Sequence templates: "HDCity_Group_Template" with "Qualify_HDCity" and "Page-
Print_HDCity" sequences.

Create a New Job

1. In the Prinect Cockpit, go to "Jobs" and click "New Job". The "Create new Job" dialog opens:

�

�
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2. This dialog has four views that you can go between with "Next" or "Back". First fill out the boxes 
in the "Basic job data" view.

· Assign a job number. You can take the job number, for example, from the job ticket of a 
customer job. Job numbers must be unique in the Prinect DFE system environment. This 
means that each job number can be assigned only once. In this example, we will assign 
"HD0001" as the job number.

· Your next step is to assign a job name. Job names as well must be unique. When you go 
to the "Job Name" box, the job number is copied automatically to this box. You can use 
the job number e.g. as a prefix for the job name or overwrite it. We will assign 
"HD0001_HDCity" as the job name.

· In the "Documents" box you can now assign the documents (supplied by the customer) 
to the job. You can also do this step later in the created job. We will not assign any doc-
uments at this point.

· By default, "Job Group" and "Job Home" are linked. This means that if you define a new 
job group, a folder of the same name will be created automatically for this job group. We 
want to create a new job group and click "Change". The "Select Group" dialog opens:
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3. Enable the "Start Job" option. Leave "Maximize Job View" disabled.

4. Click "Next" to open the "Customer Data" view:

• Click the plus sign beside 
"PRJOBS". Another edit 
box displays.

• We will assign "MyPrint-
shop" as the group name 
and click "OK". The "Select 
Group" dialog closes.
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5. Select "HD_Printshop" in the "Customer Name" list box. This item is taken from customer 
administration of Prinect DFE. "Customer ID" and "Nickname" are also taken from there. "Cus-
tomer Job ID" and "Customer Job Name" are copied from the basic job data you defined before-
hand. You can overwrite these items if you have other customer job data that differ from the job 
data set in the Prinect system. We will leave these items as they are.

6. Click "Next" to open the "Processing" view: In this view, you can add prepared sequence tem-
plates to the job. Click "Add". The "Select Templates to Add" dialog opens:
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7. Select "HDCity_Group_Template" and click "OK". The group template contains all the sequence 
templates needed for processing this job.

Note: You could also add Qualify and PagePrint as separate sequence templates instead of 
the group template. In this case, the same functionality would be available.

�

�
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8. Enable the "Save as default" option. Then the "HDCity_Group_Template" will be assigned auto-
matically to all new print jobs created in the future. If required, you can undo this assigned tem-
plate by marking the group template and clicking "Remove" and then assign other sequence 
templates or group sequence templates. In addition, the group template is enabled for auto-
mated job processing. See chapter "Automatic Creation and Output of New Jobs using Drag-
and-Drop" and chapter "Automatic Creation and Output of Print Jobs in the Hotfolder Mode". 
Click "Next".

9. The "Scheduling" view opens. In this view, you can select the person responsible, enter a due 
date, set the job type and assign a job priority. Leave these settings as they are. Enter "36" in 
the "1up"/"Pages" box. Enter "5000" in the "Delivery quantity" box.

HD
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10. All the data needed for creating the new job are now entered. Click "Finish".

The new job is created and opens in the "Job" view. Double-click the caption bar of the "Job" view to 
maximize the width of the window.

Note: In the "Job" view, several jobs can be open at the same time. Each job opens in its 
own tab. You can open another tab by clicking the "plus" sign above the job tabs. In this new 
tab, you can open another job without closing the jobs opened so far. You can find more 
details about this in the Online Help of the Cockpit in "The HEIDELBERG User Interface > 
The Cockpit User Interface > Open Jobs View".

Edit a New Job

After you created the new job, you must run some steps in the open job.

Add documents

1. Go to the "Documents" step. In this step, the document files that will be edited and finally 
printed are added to the Prinect workflow.

2. To add the document PDF files to the job, you can either drag-and-drop the files from the file 
system (Windows Explorer, Macintosh Finder) to the window (1) or you can open a file selection 
dialog with the "Add Files" button (2).

3. Click "Add Files". The "Add Files" dialog first displays the content of the "PTConfig" folder on the 
DFE server.

4. In the "Look in" list box, go to the "PTDocs" folder of the DFE server. Open the "Testjobs\HDC-
ity\PDF" folder here (this job is an example; you can also use other suitable PDF files).

�

�
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5. Highlight the "HD_City.pdf" file and click "OK". The PDF file is transferred to the "Documents" 
work step and immediately processed with the "Qualify" sequence because the "Start Job" 
option was enabled when the job was created. The processing status is displayed with a prog-
ress bar.
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Add documents using drag-and-drop

As an alternative to the "Add Files" button, you can also add PDF documents to the "Documents" step 
by dragging-and-dropping them from a Windows Explorer window (or Macintosh Finder window):

1. In addition to the Prinect Cockpit, open the Windows Explorer and go to the folder where the 
files you want are located.

2. In the example, mark "HD_City.pdf", drag it holding down the left mouse button to the "Docu-
ments" area in the open job or to the "Documents" processing step icon and let go of the mouse 
button. Adding documents using drag-and-drop to the processing step icon works even if the 
step is not open at that moment.
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Because the job was activated before you added the files, the PDF documents are processed imme-
diately by the "Qualify_HDCity" sequence. After processing is finished, the documents will have 
"Completed" as their status.

Edit colors

In the "Colors" section, you can check whether, for example, the added documents contain spot col-
ors. For digital printing, spot colors are usually replaced by the CMYK process colors – unless the dig-
ital printing press has its own spot colors that correspond to the spot colors defined in the job. The 
"recipes" for the spot color replacement are usually included in the PDF files. Our example shows 
how a spot color replacement can be defined or changed in the job settings.

1. Click the small arrow in the top left icon (1). A list box with the parameter sections available in 
the job is offered. Select the "Colors" section.

The colors found in the loaded documents display in this view. For example, in the "HDCity" 
booklet, "PANTONE 281 CV_cmyk" displays as a spot color in addition to the CMYK process col-
ors:
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2. The CMYK substitute values for this spot color display in the relevant table columns. These val-
ues were already defined in the PDF files. You can overwrite the values for C, M, Y and K if you 
wish to change this "color recipe". The result displays immediately in the spot color patch.

After your input, the information in the "Source" column switches automatically from "PDF" to 
"Job". This indicates that spot color replacement for this color no longer uses the definition in 
the PDF document but that it was modified as a "job setting" and is applied in this form to the 
current print job. You can create a new spot color with the "New Color" button. You can import 
spot colors available in Prinect DFE color table database to the job with "Import Colors". Con-
firm changes to the settings with "Save".

3. In our example, leave the default settings as they are.

Set up and output digital printing

Note: You can find details about these options in the Online Help of the Prinect Cockpit > 
"Digital Printing Step" (invoke with the F1 key).

Go to the "Digital Printing" step. In this step, you can interactively impose (PDF) documents on a (dig-
ital) print sheet, set delivery and finishing options as well as configure the color settings of the press 
and submit the imposed print sheet for output.

�

�
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The window structure is as follows:

• The left part of the window (1) is where the single pages display. These pages have already been 
automatically assigned to the page placeholders of an automatically generated page list.

• The preview pane (2) shows a preview of the sheet layout. The appearance of the sheet layout 
depends on the imposition parameters configured in the right-hand area of the window. You can 
choose between different views and use various tools to see detailed information about the 
pages shown.

• You can set all the parameters that are required for imposing the pages on the printing material 
and for setting up the press (display, finishing) in the various tabs in the setup pane (3):

· "Paper and page settings",

· "Layout settings",

· "Print mark settings",

· "Color settings" and

· "Print and finishing settings".

The basic output parameters were already set up in the settings of the loaded 
"PagePrint_HDCity" sequence template (see section "Configure a PagePrint Sequence", page 
30). You can modify the output parameters here if required. These settings affect the open job.

Color settings

In the "Color Settings" tab, you can define settings for spot color replacement that cannot be set by 
default in a PagePrint sequence:
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In "Spot Colors" you can configure custom settings for replacing spot colors in the current job by 
clicking "Spot Color Matching" (1).

Note: The settings always relate to a specific paper type on a specific press. These settings 
always affect all digital print jobs until you change these settings again.

The "Spot Color Matching" dialog opens:

�

�
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1. In the "Color Name" list box, first select the spot color for which you want to define a substitute 
color. All the spot colors that are in the current print job are listed.

The original color displays in the middle color patch "C4" in the preview window. Modified colors 
display around the original color. Colors that cannot be output correctly to the paper set in the 
print job are marked by an "x".

The aim of these settings is to determine a color that can be output correctly, in other words, a 
color that is not marked by an "x".

2. Click "Print Test Page". A test chart is printed.

Note: Each test chart printout creates a new separate print job in the DFE. These test chart 
print jobs are set up with the color settings that are required for a true-color output.

3. Now compare the printout of the test chart with the original copy and determine the color patch 
that best matches the original spot color.

4. If the deviation is still too big, enable either "Lightness/Chroma" and/or "Color Cast" in 
"Correction" to set the type of color change. Now move the "Step Width" slider until suitable 
patches display in the preview window. The larger the step width, the greater the differences 
between each of the color patches.

5. Repeat steps 2, 3 and 4 until you are satisfied that the target color is determined accurately 
enough. On the test chart, the patch with the correct color has an "address", e.g. "B 2".

6. Click the appropriate patch (e.g. "B 2") in the "Spot Color Matching" dialog.

7. The CMYK values of the original color display in "Original Color". The values of the selected 
color display accordingly in "Selected Color" (in our example, those of "B 2").

Note: If you wish, you can manually set the color of the marked color patch by entering 
CMYK color values in "Selected Color". If HEIDELBERG Inkjet digital presses (e.g. Labelfire) 
are used, L*a*b* values display in this case. You cannot edit these values because these 
printing presses use a Multicolor color space.

8. Enable "Edit alternate color in job colors" if you wish to set the alternate color only for the 
current print job.

If the alternate color is to be set always for the paper type used, enable "Use alternate color 
always for selected paper type "..." on (...)" and select the paper type in the "Customize 
for" list box. Then these settings affect all print jobs that are printed with this paper type on this 
press. This setup is applicable until you edit it again.

9. If you are satisfied with the colors selected, confirm the dialog with "Save".

Use the "Delete" button to reset all the settings so that special spot color settings are no longer 
defined for the particular paper type/press combination.

The "Paper Type" and "Output Device" boxes are for your information only.

Editing options in the preview pane

Note: You can find details about these options in the Online Help of the Prinect Cockpit > 
"Digital Printing" step (invoke with the F1 key).

�

�

�

�

�

�
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In the preview pane, different view and check options are available:

• Toggle the view mode between sheet, layout, separations, area coverage and reading view

• You can use the hand tool to move the image content of the preview.

• You can measure dimensions with the dimensioning tool.

• Use the zoom tool to set the display scale of the preview.

• Use the magnifying glass tool to zoom in on a section of an image like a magnifying glass.

• The info tool provides detailed information about a specific part of the preview.

• The "Color Matching" function function lets you customize color reproduction in digital printing.

"Color Matching" function

Sometimes it is necessary to fine-tune color reproduction in digital printing just before printing, based 
on what you see on the screen. The "Color Matching" function lets you define such color settings 
based on a master page taken from the current print job. These settings only affect the print job that 
is currently being edited.

Prerequisite: If this functionality is to be used for a realistic proof preview of the expected 
print results, the screen used should be color calibrated and suitable as a proof monitor.

1. In the preview window, mark a page that contains one or more image objects that are suitable 
for evaluating color matching.

2. Click "Color Matching". The "Color Matching" dialog opens:
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3. In this dialog, you can adjust gradation parameters "Lightness", "Contrast", "Highlights" and 
"Shadows". You can check these parameters in a gradation curve in addition to the preview.

4. Apart from these, you can also set color parameters "Chroma", "Blue-Yellow" weighting and 
"Green-Red" weighting. You can review these settings in the page preview.

5. You can set the gradation and color data either using the sliders or by entering values.

6. There are seven buttons in the lower left part of the "Color Matching" window:

Use the five left buttons to alter the separating line between the original and the customized 
area of the image preview. You can choose between the following settings:

· No separating line (the whole preview window shows the customized color data)

· Horizontal separating line, the preview is split horizontally

· Horizontal separating line, the preview is duplicated

· Vertical separating line, the preview is split vertically

· Vertical separating line, the preview is duplicated

You can use the two "magnifying glass buttons" to scale up or down the preview.
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7. The "Reset" button lets you reset all the settings to their original values.

8. Click "OK" to apply the settings to the whole print job and close the "Color Matching" window.

Save settings as a PagePrint sequence template

If you changed output parameters, you can save the new settings as a PagePrint sequence template. 
You can then use this template for other print jobs. In the case of the current print job, you do not 
have to save the settings as a separate step. They are automatically saved with the print job.

1. The currently active PagePrint sequence displays above the parameter tabs. In our example, this 
is "PagePrint_HDCity" (1).

2. Click the "Save Template" button (2). The "Save Template" dialog opens:
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3. This is where you can assign a new name. The settings are then saved as a new PagePrint 
sequence template. If you do not wish to change the name of the sequence, the existing "Page-
Print_HDCity" sequence is overwritten with the new settings.

4. Confirm the dialog with "OK". Confirm the alert message that appears also with "Yes".
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Printing

1. To check your print and finishing settings, go to the "Print and finishing settings" tab. Define your 
setup as required.

2. Click "Submit" (1) to start printing.

The "Submit" dialog opens:
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3. In this dialog, you can assign a priority, correct the delivery quantity, set front and back proper-
ties, assign a work type, enter a comment and set the time for printing. In this dialog, the terms 
"number of 1ups" or "number of pages" and "print quantity" have the following meaning:

· Number of 1ups/Number of Pages: If you want to print a specific number of pages or 
1ups, select the "Number of pages" option. The number of pages/1ups that have been set 
will be printed.

· Print Amount: Here you can set the print amount. The print amount depends on the 
type of product to be printed:
If a product is printed with multiple pages, e.g. with two A4 pages on A3+ paper, the 
print amount refers to each (multiple) occurrence of each page of the PDF document.
If a single-use product is issued, such as a brochure, the print amount refers to the num-
ber of copies issued.
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(4). The "Test Print" option (1) is only available for toner-based HEIDELBERG digital printing 
presses, such as Versafire machines. If you enable this option, you can print the job as a test 
print, for example to check the color quality. Enabling this option has the following impacts:

· The print amount is automatically set to "1" because usually you need only one copy as 
a test print. You can increase the print amount manually, if required.

· The work type is set to "Internal".

· The parameters in the "Scheduling" section are disabled.

· After output, a test print is not tagged as "finished".

If the job is to be output normally after the test print, all you have to do is submit it again and 
disable the "Test Print" option. The parameters set beforehand in the "Submit Elements" dialog 
are enabled again.

5. The print job is submitted to the Digital Printing Terminal when you confirm this dialog with 
"OK". In this sample configuration, the print job is submitted directly to the press because the 
automatic output mode is enabled in the Digital Printing Terminal (see section "Configure the 
Digital Printing Terminal", page 39).

6. After output, you can close the print job.
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Automatic Creation of New Jobs using Drag-and-
Drop

The Prinect DFE lets you use a predefined print job as a template for other print jobs and outputs. 
The documents of the subsequent print jobs are then processed with all the job settings of the tem-
plate job. To create and start a follow-up job, you simply need to drag and drop the PDF documents 
you want to output from Windows Explorer (or Mac Finder) onto the corresponding template job in 
the cockpit's job list. This process is explained in more detail below.

Prerequisites for the Drag-and-Drop Mode

For this workflow, some prerequisites must be met on the Prinect DFE computer so that automated 
job processing works smoothly.

Prerequisite: The following requirements must be met for output with a reusable print job:

· A print job for digital printing must be defined as a template job and it must have all the 
required matching settings (sequences, imposition and finishing parameters).

· The print job condition must be "Idle" and the processing status must be "OK". The print 
job must be closed before output and it must be seen in the Cockpit job list.

· The sequences required must have been assigned to the print job as a template, either 
separately or as a group sequence. This ensures the automated processing of printing.

· The documents to be output must be able to be edited without an error and their page 
size must match the imposition settings in the PagePrint sequence. The number of pages 
does not have to match the page total defined originally in the PagePrint sequence. It will 
be matched automatically during output.

Prepare a Print Job

We will use the "HD0001_HDCity" booklet print job as our basis, like in chapter "Manual Creation of 
a Print Job".

After the "HD0001_HDCity" job was configured and used successfully for output of the "HD_City.pdf" 
document, you will now create a similar job for automated output.
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1. Go to "Jobs" view, mark the "MyPrintshop" group in the job list, and click "New Job".

2. Fill out the "Basic job data" view as follows:

• Job number: HD0002.

• Job Name: HD0002_Auto_DD.

• Job Group: MyPrintshop (is set by default).

• The "Start Job" option is disabled. Click "Next".
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3. Select "HD Printshop" as the customer in the "Customer Data" view. Then click "Next".

4. In the "Processing" view, "HDCity_Group_Template" is already set by default because we added 
this group sequence template with the "Save as default" option to the manually created job (see 
chapter "Manual Creation of a Print Job"). If you wish to add other sequences to the job, you can 
do this by using "Add". You can remove existing sequences – including group sequences – from 
the job by marking them and clicking "Remove".

5. No scheduling data will be entered because the job is being set up as a reusable template for 
automated printing. For that reason, we will skip "Scheduling". Click "Finish".
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The job is created and opens.

6. Double-click the caption bar (and not the tab, but next to it) of the "Job" window to maximize 
the width of the window. All the job settings and the "Documents" and "Pages" steps remain 
unchanged because different documents with the same settings will be output in an automated 
workflow. Go directly to the "Digital Printing" step (click this icon in the workflow bar).

All the required output settings are already configured because the "HDCity_Group_Template" 
contains the preset "PagePrint_HDCity" sequence.

7. Leave the settings as they are. You will find more details about the "Digital Printing" step in the 
section "Set up and output digital printing", page 55 or in the Online Help of the Cockpit (F1 key).

8. Start the job by clicking the start button (1).

9. This concludes your preparations for the automatic job. Close the job with "Close Job". All set-
tings are saved automatically.

Automated Output of Documents

1. Open the Cockpit and view the job list on the left in the "Jobs" view.

2. If necessary, open the job group (in our example, "MyPrintshop") that contains the prepared job 
and make sure that the "HD0002" job can be seen.
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We will use the "HD_City.pdf" document again as the example document.

3. Open a Windows Explorer window (or a Macintosh Finder one) and go to the folder which holds 
the PDF file to be output. This folder must be located on a local drive, data media or on a shared 
network drive of the Cockpit computer.

4. Select the PDF file(s) and drag them, holding down the left mouse button, to the "HD0002" print 
job entry and let go of the mouse button. The job then opens automatically and displays in the 
"Job" window.

5. To print the print job, maximize the width of the "Job" window (double-click the caption bar) and 
go to the "Documents" step. Wait until the documents are processed and then go to the "Digital 
Printing" step.



Automatic Creation and Output of New Jobs using Drag-and-Drop

72 Version 2021.10

(6). If required, you can customize your settings in this step (see section "Set up and output digital 
printing", page 55).

7. Click "Submit" (1). The "Submit Elements" dialog opens:
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8. In this dialog, you can still assign a priority, correct the print amount, assign a work type, enter 
a comment and set the time for printing.

9. The print job is output to the press when you confirm this dialog with "OK".

10. After output, close the print job.

Output Other Documents

Repeat steps 1 thru 10 to output other documents automatically.
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Create New Print Jobs by Copying PDF Files to a 
Hotfolder.

With the Prinect DFE you can set up a print job in such a way that new print jobs are automatically 
created when documents are filed in a folder that is set up as a "hotfolder". In this chapter we will 
set up such a print job and describe how to create new jobs.

Prerequisites for the Hotfolder Mode

For this workflow, some prerequisites must be met on the Prinect DFE computer so that automated 
job processing works smoothly.

Prerequisite: The following requirements must be met for output with a reusable print job:

· A hotfolder job template must have been set up in "Administration > Hotfolder". This job 
template must have all the required settings (sequences, imposition and finishing 
parameters) in a suitable form.

· An "external hotfolder location" must have been defined to be able to set up a hotfolder 
job template. For a Prinect DFE setup, the "\PTJobs\External-Hotfolder" folder is 
installed by default. Open "System" in the "Administration" view if you want to change 
this setting. In the tree structure, mark "System", the topmost item (if necessary, you 
must click "Hide Clusters"), and then click "Browse..." in "External Hotfolders Location" 
on the right. In the dialog that then displays, you can select a different folder or create a 
new one. You can also define an "External Hotfolders Location" on a different computer 
to the Prinect server. You can find more details about creating an external hotfolder loca-
tion in the Online Help for the Prinect Cockpit in "Administration - System". In our 
example, we will leave the default "\PTJobs\External-Hotfolder" as it is.

· The sequences required must have been assigned to the job template, either separately 
or as a group sequence. This ensures the automated processing of printing.
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· The documents to be output must be able to be processed without an error and their 
page size must match the imposition settings in the PagePrint sequence. The number of 
pages does not have to match the page total defined originally in the PagePrint 
sequence. It will be matched automatically during output.

Disable Preview Handler in Windows Explorer

The Windows Preview Handler is responsible for displaying previews of the different file types in a 
Windows Explorer window.

Problem: A Prinect hotfolder can no longer be polled correctly if the Preview Handler needs more 
than six seconds to calculate a preview. As a result, the PDF documents are not processed.

1. Open a Windows Explorer window and invoke the "Folder Options" dialog (either with "Tools > 
Folder Options" if the menu bar displays or with "Organize > Folder and Search Options" or with 
"View" > Options > Change folder and search options") (Windows 8.1/Windows 10/Windows 
Server 2012 R2/Windows Server 2016):

2. Open the "View" tab and disable "Show preview handlers in preview pane".
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3. Confirm the dialog with "OK".

Prepare a Print Job

We will use the "HD_City.pdf" booklet print job as our basis, like in chapter "Manual Creation of a 
Print Job", page 45.

Set up a Qualify sequence for the hotfolder mode

1. Open the "Qualify" sequence folder and highlight "Qualify_HDCity" (1). Click "Open" (2). Alterna-
tively, you can also open the sequence by double-clicking it.

The setup section for the "Qualify_HDCity" sequence opens:
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Set this sequence as follows:

2. Leave "Normalizing", "Split Document", "Preflight" and "Destination" as they are.

3. Enable "Hotfolder" and set the following parameters:

a. In the "Hotfolder" box (1) leave the "$Template" setting as it is. This setting makes sure 
that the file names of the job documents are used for the names of the new jobs.

b. Enable the "in External hotfolder location" option (2). With this option, the new jobs are 
stored in the set hotfolder location on the Prinect server.

c. In "Insert into external hotfolder path" (3), leave "Job Number" as it is. By doing this, a 
separate subfolder with the job number as the folder name is created for each job.

d. Enable "Create new job and process document there" (4). When this option is enabled, 
new jobs are created automatically when document files are filed in the hotfolder.

e. Select "Keep existing process network" in the list box (5). In this list box, you control how 
a process network is created automatically from components of the job name, among 
other things from the product code. A process network is a combination of print job, 
press sheets and sequences. No Smart Automation workflow will be used in our example 
and, for that reason, no new process networks will be created using this functionality.

f. In the "Job group for new job" list box (6) leave "Current job group" set. The new jobs 
generated are created in the same job group as the original job.

g. Set "Create and use job with a new job number" in the "When job number already exists" 
list box (7). Based on the existing job number, a new job number is created by appending 
an index. After that, a new job is created with this job number.

You can use "The file name contains" to determine detection rules for interpreting the 
file names of the PDF files you want to process by detecting and using certain parts of 
the file name as job parameters. You will find more details about these detection rules 
in the Cockpit Online Help in the "Sequence Templates" section in "Preparation > "Qua-
lify" Sequence Template > Hotfolder" option.
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We will use a simple example and generate only the job number and job name from the 
file names.

h. To do this, select "the job number" in the "in position 1" list box (8). Check the "from first 
character" option (9) and enter the character "#" in the "up to delimiter" box (10). As a 
result, the file name of the filed documents is interpreted in such as way that all charac-
ters before the "#" in the file name are identified as a job number and are used for the 
new jobs. The file names of the filed documents must have this delimiter and appropriate 
characters for the job number in order for new jobs to have a job number.

i. Then select "the job name" in the "in position 2" list box (11). The "from first character" 
option remains disabled. Enter the character "&" into the "up to delimiter" box (11). This 
character acts as a rear limitation for the job name. All characters between these two 
delimiters in the file name of the filed documents are used as the job name.

Example: A document named "1234#Brochure_HD&.pdf" creates a job with the number 
"1234" and job name "Brochure_HD".

Caution: When you define job names, make sure that job names and job numbers in a Pri-
nect system are always unique. A new job will overwrite an existing job if the new job is cre-
ated in the hotfolder mode and its job name and job number match those of the existing job!

4. Leave the other steps as they are and click "Save as".



Automatic Creation and Output of Print Jobs in the Hotfolder Mode

80 Version 2021.10

5. Enter "Qualify_AutoJob" as the name. Confirm the "Save Template" dialog with "OK".

6. Click "Close". The sequence overview displays.
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Create a group template for automatic job creation

1. In "Administration > Templates", mark "Group Templates" in the sequence overview and click 
"New".

The empty setup window of a group template opens.

2. Open the "Qualify" folder and select "Qualify_AutoJob" (1).

3. Then click "Add Template" (2).

An icon for the Qualify sequence is created in the workspace.

4. Repeat steps 2 and 3 also for the "PagePrint_HDCity" sequence. The workspace now displays as 
follows:
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5. In the workspace, select "AutoArrange" in the context-sensitive menu. The icons are placed side 
by side and aligned.

6. Save the group template as "AutoJob_Group_Template" using "Save as".

7. Close the view by clicking "Close". Then click "Overview".

Automatic creation of print jobs

After the Qualify sequence is configured, a new print job template is now created in "Administration 
> Hotfolder" and is used for automatic job creation. Hotfolder job templates do not display in the job 
list so that they are not inadvertently deleted. Administration of these templates is solely in "Admini-
stration > Hotfolder".

Create a hotfolder job template

1. If not already there, go to "Administration" and click the hotfolder icon.

The section for setting the hotfolder job templates opens. Click "New".
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Set up the job template as follows:

2. Enter "MyAutoHF" as the name.

3. Leave "with current date" enabled in "Job group for new job". This setting generates a separate 
job group with the current date as the group name for all the jobs created on this day.

4. Click "Import" in "Processing". Select "AutoJob_Group_Template" in the "Select Templates to 
Add" dialog.



Automatic Creation and Output of Print Jobs in the Hotfolder Mode

84 Version 2021.10

Confirm with "OK".

5. Click "Save".

The new job template, "MyAutoHF", displays on the left of the window. You can create other job 
templates with "New", if required. We now close the view by clicking "Overview". The hotfolder 
job template is now set up.
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Create a New Job by Filing to the Hotfolder

After you prepared the job template for automatic job creation in the hotfolder mode, job processing 
can begin.

Prepare Document File Names

Delimiters were defined in the hotfolder settings of the Qualify sequence and they can be used to filter 
out the job number and job name from the document file names. We will customize the file names of 
the PDF documents to be output so that we have useful job numbers and job names.

Caution: When you define job names, make sure that job names and job numbers in a Pri-
nect system are always unique. A new job will overwrite an existing job if the new job is cre-
ated in the hotfolder mode and its job name and job number match those of the existing job!

We will use the "HD_City.pdf" document again as the example document (see section "Automated 
Output of Documents", page 70).

Create and Start a Print Job

1. We will create a new folder named "PTDocs\Testjobs\HDCity_AutoJob" and copy "HD_City.pdf" 
to this folder. The file will be renamed to "GS0010#HDCityA4&P01_P36.pdf". Based on the set 
delimiters "#" and "&", a new job with job number "GS0010" and job name "HDCityA4" will be 
produced.

To output "GS0010#HDCityA4&P01_P36.pdf", you will now copy it to the hotfolder of the 
"HMyAutoHF" template job:

2. In the Windows file system, mark the file and select "Copy" in the context-sensitive menu or click 
on "Copy".
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3. Go to the hotfolder of the "MyAutoHF" job. You will find this folder on the Prinect server in the 
"PTJobs" folder and there in "ExternalHotfolder\MyAutoHF".

4. Select "Insert" in the context-sensitive menu. By inserting the PDF file, you automatically gener-
ate a new print job.
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5. In the Cockpit, go to "Jobs" and there to the job list. After a brief period, a new group with the 
current date displays below "PRJOBS". This group contains the new job "GS0010".

This job starts, is processed and can be output automatically.

6. To output the print job, wait until the documents are processed and then go to the "Digital Print-
ing" step.
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(7). If required, you can customize your settings in this step (see section "Set up and output digital 
printing", page 55).

8. Click "Submit" (1). The "Submit Elements" dialog opens:
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9. In this dialog, you can finish off, for example, by running a test print (1), assigning a priority, cor-
recting the delivery quantity and/or entering a comment.

10. The print job is output to the press when you confirm this dialog with "OK".

11. After output, close the print job.

Output Other Documents

Repeat steps 1 thru 10 to output other documents automatically.

Caution: When the "master job" stops, the related hotfolders will also be deleted! For that 
reason, make sure that the condition of the master job is always "Idle".

In this way, you can automatically generate more print jobs.
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A

Location

Locations in the Prinect Manager are clearly defined folders where resources (ICC profiles, preflight profiles, dynamic marks) and sequence templates installed by default are filed. Job locations can also be defined. Such a folder is then suggested by default as the de fault job folder. Hotfolders that are not located in the "PTJobs" folder, in contrast to the default, can also be defined as a "hotfolder location".

Acrobat portfolio

As of Acrobat version XI,  several PDF files, and even other files of a different type, can be grouped in an "Acrobat portfol io". The Prinect Normalizer can unpack Acrobat portfolios and copy the PDF pages in them to a print job. The names of the pages are based on the name of the portfolio.

Module

A print job generally consists of several operations. In order for an operation to be processed by a machine, at least one module is required in all cases. For example, the "Printing unit"  module is required for a printing press. So that it can also process jobs involving print enhancement (varnish), this press also requires the "Coating unit" module.

Analyze Point

"Analyze Point" is a module that in conjunction with the Prinect Integration Manager (or Pressroom and/or Postpress Manager) can analyze production data (times, processed jobs, operators, etc.) that were recorded by suitably equipped machines (presses, finishing devices). Precise job costing of the print jobs is possible using Analyze Point and a connected MIS.

Bleed box

The bleed box represents an extended area around the trim box. The entire page contents are trimmed by this amount when a bleed area is defined. A document requiring a bleed also requires a bleed box. The bleed box is always larger than the trim box and smaller than the media box. The bleed area of a printed page can have print,  folding and cut marks, slug lines, etc.

Bleed

The purpose of the bleed and/or trim allowance is to avoid unprinted (white) margins on the cut edges when cutting the printed pages. To do this, the page contents of a certa in area are printed larger than the basic page size (e.g. A4) so that the cut edge is within the printed area. The "Bleed" dimension determines by what extent the bleed box is larger than the page trim box.

Operation

Operation re fers to a single processing step in the print production process. Examples for operation are platemaking, press setup (makeready), printing, folding, cutting, etc.

Action

Actions are uninterrupted successive periods portraying the processes at a workplace.

Archive System

The "Prinect Archive System" lets you archive the jobs defined in the Prinect Manager to external storage media. If you have suitable storage media and the archiving software is installed, you can control the archiving and retrieval of jobs from the  Prinect Cockpit. The "Archive" and "Retrieve" sequence templates are available for this. In other words, you can set up and use archiving and retrieving processes like a workflow sequence. In this way, you can archive a job, for example, by submitting it to an archiving sequence.

Job

A job is an element in the Prinect Manager that contains all the  basic data and definitions of the processing steps required for creating a customer print job. The basic data include, for example, the documents to be processed, sheet layouts, customer data, printing materia ls, etc. The processing steps are defined as reusable sequences. You can assign different sequences to each job. Each job has a name and a unique job number.

B

PDC

PDC is the abbreviation for production data collection. Suitably equipped machines (presses, f inishing devices) can send their production data (times, processed jobs, operators, etc.) to the Prinect Integration Manager. The production data can be forwarded to a connected Management Information System and be assessed in detail, for example, with the "Analyze Point" module.

Accompanying papers

Accompanying papers refer to the various papers that accompany a quantity of goods (e.g. pallets, plates, etc) to the next step in their processing (e.g. press or finishing). Accompanying papers contain all relevant details needed for the  next step in goods processing.

Trim allowance

The trim allowance defines how much larger the folding sheet is than the page trim box. It may be necessary, for example, to trim the size of the pages to the size of the folding sheets before folding, then to fold the pages, and finally to trim the pages to the size of the trim box.

Black point compensation

In gamut mapping, all L shadows that are darker than black ink are matched to black ink and, as a result, shadow definition is lost. Black point compensation enhances the reproduction area when the "Relative colorimetric" rendering intent is used for color space conversion to the L*a*b* color space or from the L*a*b* color space to the device color space.

Bounding boxes

When assigning PDF data pages to a sheet layout, it is important to know which bounding boxes are in the PDF file and how Prinect Signa Station evaluates them. The fol lowing boxes (sorted by box size) in a PDF document can be evaluated by Prinect Signa Station: media box, crop box, bleed box, trim box, art box.

Work type

Work types are used in the Management Information System (MIS) to identify relevant elements (consumables, working times, etc.) for accounting entries.

Chroma

Chroma (C*) describes the intensity of a color we perceive. It describes what makes this color different from one which is perceived as achromatic and has the same degree of brightness. Terms such as gray, pastel-colored, very chromatic, etc. are used to describe this property. Chroma depends greatly on lightness. Colors perceived as being very light or very dark have only a slight amount of chroma.

Chromatic value/achromatic value

Each tertiary color or color shade can be divided into two parts: a chromatic and an achromatic value. The gray component contained in the mixed color is defined as the achromatic value. In chromatic reproduction with ideal process colors, it consists of equal parts of cyan, magenta and yellow. These parts neutralize each other, lose their chromatic nature and as a result appear achromatic. With ideal process colors, the achromatic value can be replaced partly or entirely by black. Achromatic reproduction takes place when the achromatic value is removed complete ly.

C

CDM

In the  Prinect Manager, configuration and administration of the connected machines are done in the "Central Device Manager". The abbreviation "CDM" is used.

CIE XYZ system

International uniform standards for evaluating color stimuli were established in 1931 by the Commission Internationale de l'Eclairage  (CIE), the International Commission on Illumination. Color-matching functions with three imaginary light sources (X, Y and Z) were defined to describe a standard observer whose visual perception corresponds to what the average person sees. The spectral curve for "Y" (l) was chosen to be equivalent to the human perception of l ightness. So-called tristimulus values are calculated both from the spectral curve of the color and from the color-matching functions.

CIELAB color space

CIE established the fundamentals for the L*a*b* color space in 1976, and which is usually re ferred to as the CIELAB color space. LAB denotes a color coordinates system which is closely related to visual perception. The CIELAB color space consists of the  lightness axis L*, the red-green axis a* and the yellow-blue axis b*. The distances in this color space are the  same and reflect approximately what we perceive. This color space can be calculated from or to the CIE XYZ color space on the basis of clear mathematical correlations. The L* value describes the lightness of the color and can lie between 0 (for absolute black) and 

100 (for reference white). Color coordinates a* and b*, which can have positive and negative values, define its chroma.

CIP4-PPF

In prepress, certain data, e.g. ink zone control, can be created as CIP4-PPF files and modified in the whole workflow and finally processed by the press. The  CIP4 Print Production Format (PPF) is defined and updated by the CIP4 group (www.cip4.org). PPF files are transmitted to the Prinect Manager via a PPF import interface.

Cockpit

The Cockpit is the user interface for various Prinect Managers (Integration Manager, Digital Front End, Prepress Manager, Pressroom Manager, Postpress Manager).

Color Carver

The Color Carver is the engine that is responsible for color management in the Prinect workflow.

Prinect Archiver Pro

The Prinect Archiver Pro is a database application that lets you save and manage content data for print production.

D

Data Terminal

The Data Terminal is a special workstation that is used to connect machines without an internal interface to the Prinect system environment to the Prinect workflow. You can send operating data to the Prinect Manager server using the Data Terminal.

DeviceLink profiles

DeviceLink profiles are  special color profiles that are used in color management. DeviceLink profiles describe color transformation that bypasses the L*a*b* color space and overwrite the output profile normally used for the transition from the L*a*b* color space to the output device. Doing without the L*a*b interim color space gives you controlled transformation especially of the K separation.

DieLine

The "DieLine" spot color is used on Prinect Signa Station in the marks layer. Lines in this color describe the pages and the sheet format.

Service

Many functional elements of the Prinect Manager are implemented as Windows services. Services generally do not have their own user interface and start and run in the background without the user seeing anything about this. Prinect services can be checked in the user interface of the Prinect Supervisor and can be started or stopped manually if required.

Digital Print Connector

The Prinect Digital Print Connector lets you connect digital presses of other manufacturers to the Prinect workflow. Ricoh, Hewlett Packard, Xerox, Canon and Kodak digital presses are supported. Connection of these digital presses is through virtual printers. These are machine configurations that are set up at the user interface on the terminal PC of the respective press.

Digital Front End

The Digital Front End (DFE) is the variant of the Prinect Manager designed for digital printing. The Digital Front End fully supports the digital printing workflow for Heidelberg and Gallus digital presses and with restrictions for digital presses of other manufacturers.

DFE

The DFE (Digital Front End) is the variant of the Prinect Manager designed for digital printing. The Digital Front End fully supports the digital printing workflow for Heidelberg and Gallus digital presses and with restrictions for digital presses of other manufacturers.

Dongle

The dongle is a USB stick and must be plugged into the License Server. Only when a dongle is activated can the License Server enable the purchased options.

Press sheet

In Prinect Signa Station, the term 'press sheet' is the same as 'plate' ("Plates" step, Press Sheet Inspector). The press sheet is the same as the plate template with placed folding sheets.

DSC

 information can be found in PostScript documents..

E

Trim box

The trim box specifies the final page size after printing and cutting. The trim box is the same as the term "trimmed size" found in Prinect Signa Station. If a PDF document has a trim box, the trim box should be identical in size to the trimmed size of the page. The trim box must be smaller than the bleed box or media box.

Engine

In the  Prinect Manager, the various tasks are done by engines. This means that there are engines for preflighting (initial check) the print jobs, for color management, for rendering, etc. The  engines can be installed on one central  Prinect server or on several dedicated engine computers.

EPS

EPS (Encapsulated PostScript) is a device-independent PostScript code. In other words, it does not have any format-dependent information.

F

Folding sheet

A folding sheet is defined when you give a folding scheme dimensional data. In Prinect Signa Station, this is done by assigning master pages or page sizes and gaps between the pages (head, foot and page trims). A folding sheet is the "central unit"  in finishing. The folded sheets can be placed in the stacker of a saddlestitcher. The saddlestitcher then gathers the sheets from the stackers and binds them with staples (saddlestitching). A folding sheet contains a folding scheme, assigned pages and marks (cut, folding and col lating).

Folding scheme

A folding scheme describes how the sheets will be folded in finishing. A folding scheme doesn't have any dimensional data. It only tells you that there are a certain number of pages on a folding sheet and defines how they must be folded.

Color space conversion

Color space conversion basically matches the image or graphic data from the creator color space (e.g. color space of a digital camera) to the color space of the output device or process (e.g. color space of a press or color printer).

G

Gamut

Gamut is the set of a ll colors that a device (e.g. monitor, printe r, scanner, f ilm) can display, reproduce or record. Formally, gamut is the range in the color space that can be altered to the output device by internal color blending.

Device class

In a print workflow, device class refers to a specific type of machine (press, digital press, cutter, folder, etc.) or other work processes that occur in the workflow (prepress, e tc.). Device classes are needed in the MIS to define cost centers.

Gradation

A gradation (reproduction of the tonal value) defines the relation between the original density and the reproduction density. With transparent originals, density is defined as the logarithmic ratio of transmitted light to incident light, with reflective originals, it is the logarithmic ratio of reflected light to incident light.

Gray balance

Gray balance de fines the ratio of the three chromatic inks cyan, magenta and yellow to each other so that gray tones in the original are also gray, i.e. neutral,  in the reproduced image. Gray balance depends on the paper used, in particular on its hue, on the process colors and their intensity in print. It also depends on the printing process and the printing form. Visually, magenta and yellow penetrate more than cyan. For that reason, the value for cyan is generally greater than the value for magenta and yellow to produce a neutral tone in the overprint. Same amounts of cyan, magenta and yellow produce a brownish hue in the overprint.

Group templates

Group templates are a number of single sequence templates that can be linked together as a group. Predefined workflow configurations can be used again and again by assigning group templates to new print jobs.

H

Gray balance de fines the ratio of the three chromatic inks cyan, magenta and yellow to each other so that gray tones in the original are also gray, i.e. neutral,  in the reproduced image. Gray balance depends on the paper used, in particular on its hue, on the process colors and their intensity in print. It also depends on the printing process and the printing form. Visually, magenta and yellow penetrate more than cyan. For that reason, the value for cyan is generally greater than the value for magenta and yellow to produce a neutral tone in the overprint. Same amounts of cyan, magenta and yellow produce a brownish hue in the overprint.
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H

Lightness

In a color, lightness defines the amount of light reflected from the surface. It is influenced by the way a surface reflects impinging light. Reflectance refers to the way light is reflected off the surfaces of non-luminous bodies. The minutely f ine unevenness of the surface ensures that a mirrored image does not result but that the image is remitted diffusely (scattered). Lightness describes the intensity of light in a color. Terms such as dark, light, very light, etc. are used to describe this property. Colors with the same spectral distribution but different lightness are different colors.

Hexachrome

PANTONE® Hexachrome is a color space that is made up of the six primaries (cyan, magenta, yellow, black, orange and green) instead of the four primaries (CMYK).

Hifi Color

Hifi Color is a color space that is made up of the seven primaries (cyan, magenta, yellow, black, red, green and blue) instead of the four primaries (CMYK).

Hotfolder

A hotfolder is a folder in the file  system that is monitored permanently by an application or a Window service for changes. Whenever files of a certain type are copied to a hotfolder, the application/service runs certain actions on these files. For example, a hotfolder can be defined in a Qualify sequence. All PDF files that are filed to this folder are processed automatically by the Qualify sequence.

I

ICC profile

An ICC profile (synonym = color profile) is a standardized set of data that describes the color space of a color input device or color reproduction device (e.g. monitor, printer, scanner, etc.). The aim of a systematically applied color management is for source material that was captured with an input device to be  reproduced as similarly as possible on any output device. Color management systems can synchronize devices like scanners, digital cameras, monitors, printers as well as filmsetters and platesetters. The color displays according to the print conditions, for example. ICC is the abbreviation for the  International Color 

Consortium, an association of a large number of manufacturers of graphic, image processing and layout applications, founded in 1993 with the a im of achieving standardization in color management systems.

Slugline

A slugl ine is a print mark containing manually created text.

Integration Manager

Integration Manager refers to the most comprehensive variant of the Prinect Manager versions. The Integration Manager can be used in an offset printing environment, a digital printing environment and in a hybrid offset and digital printing environment. In a hybrid workflow, parts of print jobs can be output in digital printing and other parts in offset printing.

Inspection Level

Inspection Level is a level in PDF documents that contain Inspection Control marks. These documents can be used by the press module, Heidelberg Inspection Control.

J

JDF, JMF, XML

Internal data in the Prinect Manager are exchanged as "JDF" (Job Document Format) and as "JMF" (Job Messaging Format) documents. These formats are based on "XML" (Extended Markup Language) in a form especially designed for prepress. Alongside the job JDF data, the XML format is also used for the data that is required for internal system administration. The engines of the Prinect Manager, for example, have configuration files in XML format. The templates for sequences or sequence groups are also saved as XML fil es. XML files are also used for resources such as printing materials or sheet layouts. The JMF format 

is used for information transfer within the Prinect system.

JPEG 2000

"JPEG 2000" is a further development of the JPEG (Joint Photographic Expert Group) ISO standard. A higher compression rate and a better quality than with the other compression methods is achieved through a different transformation method ("Wavelet") . Compression of images using JPEG 2000 takes quite a lot of time.

K

Cost center

Cost centers are required in a Management Information System to assign precise costs to single processing steps in the  print process. One or more device classes are assigned to a cost center in order to define a device-specific cost center.

L
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"JPEG 2000" is a further development of the JPEG (Joint Photographic Expert Group) ISO standard. A higher compression rate and a better quality than with the other compression methods is achieved through a different transformation method ("Wavelet") . Compression of images using JPEG 2000 takes quite a lot of time.

K

Cost center

Cost centers are required in a Management Information System to assign precise costs to single processing steps in the  print process. One or more device classes are assigned to a cost center in order to define a device-specific cost center.

L

License Manager

The License Manager is the user interface for the License Server. In the License Manager, you manage the licenses, enable single licensing options, save the existing licensing data, etc.

Delivery quantity

For jobs without versioning, the delivery quantity is equivalent to the print run quantity. If you are working with versioning (language-specific parts are processed in a special versioning workflow), delivery quantity refers to the quantity that will be produced per version. The sum of delivery quantities per version gives you the total delivery quantity or print run quantity.

Linearization

In the  Prinect Manager environment, linearization refers to the standardization of the screen dot sizes during imaging of the plates. Screen dots become larger during this process because of scattered light. Inaccuracies in the screen dot size result in errors in color reproduction. Linearization makes sure that the size of the physical dot on the plate is the size needed to correctly produce the tonal value set in the master copy.

License Server

The License Server refers to a computer on which the License Server software is installed. This does not have to be the same computer as the one on which the Prinect server software is installed. In large system environments with a great number of Prinect products, it may be advisable to install a dedicated License Server.

M

Marks

Marks are elements (lines, crosses, circles, color control bars, text, etc.) that are placed on a sheet layout generally off the page content. There are several types of marks depending on their purpose, for example, register, cut, fold, collating, page and custom marks as well as color control bars.

Crop box

The crop box defines the area the page content is cropped to for display or output. In contrast to the other box types, the crop box does not tell you anything about the physical page geometry or intended use. I t merely defines how the page contents are cropped. The crop box defines the way the page contents are positioned on the output medium if no other information is available (e.g. imposition instructions in a JDF or PJTF job). The crop box is smaller than the media box.

MDS

The master data store (MDS) permits central administration of so-called master data for the entire Prinect system. Master data is information that can be used at several points in the Prinect workflow, for example, customer data, printing materials or colors.

Media Box

The media box contains all the objects of a page. This includes all texts, images and marks that appear on the page or extend beyond the page edge. From a technical point of view, the media box defines the limits of the physical medium on which the page is to be printed. Apart from the complete page, it can comprise space for trim marks, color control bars and other elements. The media box is the largest box type.

MIS

MIS is the abbreviation for Management Information System. A Management Information System is generally the interface to customer jobs. I t can be used for calculation of costs and deadlines and, when used in conjunction with Analyze Point for example, can supply precise details from the production data collection and make job costing possible. The Prinect Integration Manager is designed optimally for interaction with the Prinect Business Manager but can also be connected to other MIS products.

Assembly block

An assembly block is very similar to a folding sheet. It is a type of scheme with the required number of 1ups and their distribution. All the 1ups of an assembly block have the same trimmed size (analog to the master page in the folding sheet).  You can also define different-sized gaps between the 1ups. Unlike the folding sheet, an assembly block is not folded but finished in a cutter.

Master Page

The master page specifies the trimmed size of the pages on the press sheet. In addition, you can also define details about the type (left page), extra space and placement of the assigned pages. By assigning master pages to a folding sheet (the folding sheet is part of a press sheet),  you define the dimension of the folding sheet.

N

Normalizing

During Normalizing, PostScript documents are interpreted and converted to a PDF format suitable ("cleansed") for processing. The Prinect Manager is designed to process documents solely in the PDF format. This means that all the steps performed after Normal izing require that the documents are available as PDFs. Normalizing is generall y not needed for documents already available as PDFs, except when transparencies are to be flattened, when PDF documents are to be converted to PDF/VT or when Japanese fonts are to be integrated.

O

Art box

The art box is an area in a page where an object, e.g. a graphic element, will be placed. The art box defines the size and position of the object within the page. Art boxes are  produced in cases when a graphic element in a DTP application is to be placed on a page and when the DTP document is to be saved as a PDF or converted to a PDF. The art box must be smaller than the bleed box.

Operation

Operation re fers to single processes in the print process, e.g. makeready, good production, cutting, folding, etc. or their cost-relevant equivalent in the MIS. This term occurs frequently in conjunction with production data collection, e.g. when certain cost factors are assigned to the single operations in the MIS and when this information is used for costing. In this context, operations are also put on a level with PDC messages (production data collection messages) or cost types in the MIS.

Output Intent

Output Intents are color conversion instructions in the PDF. An Output Intent describes color reproduction for the final target device (e.g. an offset press) on which the PDF document is to be output. Output Intents overwrite working color spaces when displaying and printing data. However, the colors in the PDF document are not converted.

P

Paper (printing material)

Paper (printing material) is the press sheet that is printed by the plate. The folding scheme or folding sheet must f it on the paper.

Plate template

A plate template describes different geometric parameters that influence plate output and in the end also offset printing. They can be press parameters such as plate size, maximum paper size, gripper margin and lead edge of print. The plate template must make sure that imaging is within the imageable area of the CTP and within the printable area of the press. The plate template is equivalent to the press sheet without the folding sheet, i.e. a lso without the folding scheme and any marks applied subsequently.

PDF/VT

PDF/VT documents are PDF documents with multiple pages that are designed for printing variable data. Such documents mainly consist of a great number of pages that are divided into "records".

PDF/X

PDF/X is a data exchange format that contains all the elements required for printing data. PDF/X is an ISO standard for the reliable exchange of digital data in prepress. The standardization of the PDF, based on defined criteria, allows PDF files to be created that meet all  of the prepress requirements exactly. In other words, PDF/X is a PDF format that is used specifically in prepress.

Postpress Manager

The Postpress Manager manages automated finishing in a Prinect environment. It supports connection to an MIS and to the Analyze Point and Scheduler modules.

PostScript XObjects

Specia l objects that cannot be described by PDF can be embedded in the PDF as PostScript XObjects.

PPF, CIP4

In prepress, certain data, e.g. ink zone control, can be created as CIP4-PPF files and modified in the whole workflow and finally processed by the press. The  CIP4 Print Production Format (PPF) is defined and updated by the CIP4 group (www.cip4.org). PPF files are transmitted to the Prinect Manager via a PPF import interface.

Prepress Manager

The Prepress Manager manages prepress in an offset environment. I t supports connection to an MIS and to the Analyze Point and Scheduler modules.

Pressroom Manager

The Pressroom Manager manages automated press control in a Prinect environment.

Primary color

Primary colors are the colors used to produce secondary colors. A primary color cannot be produced by mixing two secondary colors. Red, green and blue in additive color mixing, cyan, magenta and yellow in subtractive color mixing.

Prinect Manager

In this documentation, the term "Prinect Manager" is used in place of the variants "Integration Manager", "Prepress Manager", "Pressroom Manager", "Postpress Manager", "Digital Front End" and "Prinect S".
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